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Safety Information
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Safety Symbols

The following symbols on the instrument and in the documentation indicate
precautions which must be taken to maintain safe operation of the instrument.

— Direct current (DC) ~e Alternating current (AC)
Caution, risk of danger (refer to this
~_ Both direct and alternating current A manual for specific Warning or Caution
information)
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Safety Considerations

Read the information below before using this instrument. The descriptions and
instructions in this manual apply to all the instruments in the Keysight modular
product family. For more pertinent safety notes, please refer to the respective
User’s Guide of your modular product.

m - Do not use this device if it is damaged. Before you use the device, inspect
the casing. Look for cracks or missing plastic.

- Do not operate the device around explosive gas, vapor, or wet
environments.

- Observe all markings on the device before establishing any connection.

- Turn off the device and application system power before connecting to
the 1/0 terminals.

- When servicing the device, use only the specified replacement parts.
- Do not operate the device with the cover removed or loosened.

- Do not connect any terminal block or cables prior to performing the
self-test procedure.

- Use only the power adaptor provided by the manufacturer to avoid any
unexpected hazards.

- Electrostatic discharge (ESD) can cause damage to the components in
the device and accessories. Any cables or wires should be connected to
the plug-in connectors first and covered with the cable casing prior to
plugging it into the output connector to prevent ESD from occurring.

- If the device is used in a manner not specified by the manufacturer, the
device protection may be impaired.

- Clean the case with a soft, lint-free, slightly dampened cloth. Do not use
detergent, volatile liquids, or chemical solvents.

- Do not permit any blockage of the ventilation holes of the device.
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Regulatory Markings

C¢

ISM 1-A

ICES/NMB-001

@

Cc

The CE mark is a registered trademark
of the European Community. This CE
mark shows that the product complies
with all the relevant European Legal
Directives.

ICES/NMB-001 indicates that this ISM
device complies with the

Canadian ICES-001.

Cet appareil ISM est conforme a la
norme NMB-001 du Canada.

The CSA mark is a registered
trademark of the Canadian
Standards Association.

The RCM mark is a registered
trademark of the Australian
Communications and Media Authority.

This instrument complies with the
WEEE Directive (2002/96/EC) marking
requirement. This affixed product label
indicates that you must not discard
this electrical or electronic product in
domestic household waste.

This symbol indicates the time period
during which no hazardous or toxic
substance elements are expected to
leak or deteriorate during normal use.
Forty years is the expected useful life
of the product.
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Waste Electrical and Electronic Equipment (WEEE) Directive
2002/96/EC

This instrument complies with the WEEE Directive (2002/96/EC) marking
requirement. This affixed product label indicates that you must not discard this
electrical or electronic product in domestic household waste.

Product category:
With reference to the equipment types in the WEEE directive Annex 1, this
instrument is classified as a “Monitoring and Control Instrument” product.

The affixed product label is as shown below.

Do not dispose in domestic household waste.

To return this unwanted instrument, contact your nearest Keysight Service Center,
or visit http://about keysight.com/en/companyinfo/environment/takeback.shtmtl
for more information.

Sales and Technical Support

To contact Keysight for sales and technical support, refer to the support links on
the following Keysight websites:

- www.keysight.com/find/usbmodular
(product-specific information and support, software and
documentation updates)

- www.keysight.com/find/assist
(worldwide contact information for repair and service)
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1 Keysight USB Modular Products and Systems

Overview of the USB Modular Products and Systems

The USB modular products and systems are a range of test and measurement
instruments that offers you the choice and flexibility you need to create solutions
that are able to expand and evolve with the changes of your test requirements.

Figure 1-1 The USB modular products and systems family

Summary of the standard features of a modular product

16

Equipped with Hi-Speed USB 2.0 connectivity, capable of handling speeds of
up to 480 MB/s

Requires a PC to operate

Bundled with the Keysight Measurement Manager software for immediate
measurement start-up

Supports the Keysight Open program and is compatible with a wide range of
Application Development Environments (ADE)

Operates as a standalone instrument or as a combined module when used
with the Keysight U2781A USB modular products chassis (able to
accommodate up to six individual modules)
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Standard purchase items

For the list of standard purchase items of each modular product, please refer to
the respective User's Guides of your modular product. Verify the standard
purchase items. If anything is missing or damaged, please contact the nearest
Keysight Sales Office.

Inspection and maintenance

Initial inspection

When you receive your modular product, inspect the unit for any obvious damage
that may occur during shipment. If any damaged is found, contact the nearest
Keysight Sales Office immediately. Keep the original packaging in case the
purchased modular product has to be returned to Keysight in the future.

General maintenance

Any repair that is not covered in your modular product manual should only be
performed by qualified personnel.

1 Power off your device, and remove the power cord and 1/0 cable from your
device.

Remove your device from the bumper casing.
Shake off any dirt that may have accumulated on the device.
Wipe your device with a dry cloth, and install the bumper casing back in place.
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Installation and Configuration

18

Follow the step-by-step instructions shown in the following flowchart to get
started with the preparation and installation of your modular product.

C A. Check Your System >

Y

B. Install the Keysight 10 Libraries Suite

Y

C. Install the Module Hardware Driver

Y

D. Install the Module IVI-COM Driver

\

E. Install the Keysight Measurement Manager

Y

F. Install the BenchVue USB Modular Application

Y

G. Connect the Module to Your PC

Y

C H. Verify Your Module Connection on Connection Expert >

\

C l. Launch the Keysight Measurement Manager or >

NN YN YN Y
N AN N N N/

BenchVue USB Modular Product Application

Figure 1-2 Installation and configuration flowchart
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A. Check Your System

Prior to any installation and configuration, please ensure that your PC meets the
following minimum system requirements.

Requirement Windows® XP operating Windows Vista® operating ~ Windows 7 operating
systems systems systems
Operating system Windows XP Service Pack 3 Windows Vista (32-bit) Windows 7 (32-bit and
(or later)& Service Pack 1 and 2[°! 64-Dit)Lclld]
Processor speed 600 MHz or higher required, 1 GHz 32-bit (x86) 3 GHz 32-bit (x86)
800 MHz recommended
Memory 256 MB minimum (1 GB or 1 GB minimum 2 GB minimum
greater recommended)
Hard-disk space 1.5 GB minimum 1.5 GB minimum 1.5 GB minimum
Video Super VGA (800 x 600) Support for Directx® 9 Support for DirectX 9 graphics
256 colors or more graphics with 128 MB with 128 MB graphics memory
graphics memory recommended!®!
recommended®!
CD ROM drive or DVDROM  Required Required Required
drive [f
Browser Microsoft Internet Explorer®  Microsoft Internet Explorer 7 Microsoft Internet Explorer 7

2,

Supported Windows XP editions — Home or Professional

=

Supported Windows Vista (32-bit) editions — Home Basic, Home Premium, Business, or Ultimate

Supported Windows 7 (32-bit and 64-bit) editions — Home Basic, Home Premium, Professional, Enterprise, or Ultimate

Keysight Measurement Manger for Windows 7 64-bit support is a 32-bit application running on a WOW64 (Windows-on-Windows 64-bit)
emulator.

@,

Super VGA graphics is supported for Windows Vista and Windows 7.

=

The type of media provided with the product determines whether a CD-ROM drive or DVD-ROM drive is required.
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Software requirements Availability
Keysight 10 Libraries Suite 15.5 Available on www.keysight.com/find/iosuite
Keysight T&M Toolkit Runtime

version 2.1 Bundled with the Keysight Measurement Manager software application installer

Keysight T&M Toolkit Redistributable
Package 2.1 patch

Bundled with the Keysight Measurement Manager software application installer

Microsoft .NET Framework

version 2.0 Bundled with the Keysight Measurement Manager software application installer

20 Keysight USB Modular Products and Systems Quick Start Guide


http://www.keysight.com/find/iosuite

Keysight USB Modular Products and Systems 1

B. Install the Keysight 10 Libraries Suite

If you have the Keysight |10 Libraries Suite 15.5 or higher installed on your PC, you
may proceed to “C. Install the Module Hardware Driver” on page 23. If not, please
perform this procedure to install the Keysight IO Libraries Suite.

You must have Administrator privileges to install the Keysight IO Libraries Suite
Connection Expert.

1 Verify that your PC meets the minimum system requirements. (See “A. Check
Your System” on page 19.)

2 Disconnect any instrument that is connected to your PC and close all other
applications on your PC.

3 Download and install the Keysight 10 Libraries Suite from www.keysight.com/
find/iosuite.

Follow the instructions as prompted during the installation

Click Finish when the installation has completed.

- If youinstall a PCI card in your computer at the same time you install the
Keysight 10 Libraries Suite, a possible conflict can occur. The “New Hardware
Found” dialog for the PCI card must be closed before continuing the
installation. Otherwise the Keysight 10 Libraries Suite installation will stop
until the PCI card installation is complete.

- If you have NI software installed (such as NI MAX, etc.), then all NI services
must be stopped prior to installing the Keysight 10 Libraries Suite.

- The IVI Shared Components and IVl VISA COM Standard Components are
installed in default folders. However, if you need to install the IVI
Components in a unique location refer to “Custom Installation of IVI Shared
Components” in the Keysight IO Libraries Suite Connectivity Guide.

- If Connection Expert is already running, click Refresh All to identify any
hardware you have just installed or re-connected.

Keysight USB Modular Products and Systems Quick Start Guide 21
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- Every Keysight 10 Libraries Suite installation is a “Full installation”
In past versions of the Keysight IO Libraries Suite, an option to install
Keysight IO Libraries Suite as either as a Full version or a Runtime version
was provided. Beginning with the Keysight 10 Libraries Suite 14.0, the
installation process provides a Full installation for all users (i.e., there is no
longer a Runtime installation option). This means that every installation now
includes the development components of the Keysight IO Libraries Suite
software, which allow you to develop your own 1/0 programs. If you wish to
minimize the size of the installed software, select Custom installation; when
you get to the Select Features dialog, do not select the manuals and the
sample programs.

- The Typical setup installs the recommended features for your configuration in
standard locations on your PC. In a Typical setup, if another vendor’s VISA
software is already installed on this PC, Keysight VISA is installed as
secondary. If no other vendor’s VISA software is found on this PC, Keysight
VISA is installed as primary. (See also “Using Keysight VISA in Side-by-Side
Mode” in the Keysight IO Libraries Suite Connectivity Guide

- If the Microsoft .NET Framework version 2.0 has not previously been installed
on your PC, Keysight 10 Libraries Suite will install them; this may take up to
ten minutes. The Microsoft .NET Framework provides necessary infrastructure
for the Keysight 10 Libraries Suite utilities, as well as for .NET programming
tools and many other applications. You will only need to install the .NET
Framework once, even if you remove and reinstall or upgrade your Keysight
|0 Libraries Suite.
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C. Install the Module Hardware Driver

Ensure that your modular product is disconnected from your PC before
installing the driver.

Verify that the Keysight 10 Libraries Suite version 15.5 or higher is installed
before proceeding. See “B. Install the Keysight |0 Libraries Suite” on page 21
for more information on the Keysight 10 Libraries Suite installation procedure.

Verify that your PC meets the minimum system requirements. (See “A. Check
Your System” on page 19.)

Disconnect any instrument that is connected to your PC and close all other
applications on your PC.

Download and install the module hardware driver from www.keysight.com/
find/usbmodular.

Follow the instructions as prompted during the installation

Click Finish when the installation has completed.

Keysight USB Modular Products and Systems Quick Start Guide 23
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D. Install the Module IVI-COM Driver

The IVI-COM drivers are used to program the test instruments in an IVI-COM
environment, while the MATLAB DAQ Adaptor allows the data acquisition modular
products (U2300A Series, U2500A Series, and U2600A Series) to be controlled in
a MathWorks environment.

- Ensure that your modular product is disconnected from your PC before
installing the driver.

- Verify that the Keysight IO Libraries Suite version 15.5 or higher is installed
before proceeding. See “B. Install the Keysight |0 Libraries Suite” on page 21
for more information on the Keysight IO Libraries Suite installation procedure.

1 Verify that your PC meets the minimum system requirements. (See “A. Check
Your System” on page 19.)

2 Disconnect any instrument that is connected to your PC and close all other
applications on your PC.

3 Download and install the module IVI-COM driver from www.keysight.com/find/
usbmodular.

Follow the instructions as prompted during the installation.

Click Finish when the installation has completed.

- The IVI Shared Components must also be installed prior to installing the
IVI-COM driver. Find the IVI Shared Components at the IVl website here:
www.ivifoundation.org.

- If needed, the IVI-COM driver may also be downloaded from this site:
www.keysight.com/find/ivi-com.

24
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E. Install the Keysight Measurement Manager

Verify that the Keysight IO Libraries Suite version 15.5 or higher is installed
before proceeding. See “B. Install the Keysight |O Libraries Suite” on page 21 for
more information on the Keysight |0 Libraries Suite installation procedure.

1 Disconnect any instrument that is connected to your PC and close all other
applications on your PC.

2 Download and install the Keysight Measurement Manager software from
www.keysight.com/find/amm.

Follow the instructions as prompted during the installation.

Click Finish when the installation has completed.
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F. Install the BenchVue USB Modular Application

Verify that the Keysight IO Libraries Suite version 15.5 or higher is installed
before proceeding. See “B. Install the Keysight IO Libraries Suite” on page 21 for
more information on the Keysight |0 Libraries Suite installation procedure.

26

1 Disconnect any instrument that is connected to your PC and close all other
applications on your PC.

2 Download and install the Keysight BenchVue Complete Collection software
from www.keysight.com/find/benchvue.

Follow the instructions as prompted during the installation.

Click Finish when the installation has completed.

5 Double-click the Keysight BenchVue icon(g) to open the BenchVue
software.

6 On the main page, click Applications to view the list of application. Below are
the list of USB modular applications you may need to install depending on the
product:

- BenchVue USB Modular DAQ
- BenchVue USB Modular DMM
- BenchVue USB Modular Oscilloscope
- BenchVue USB Modular Function Generator
- BenchVue USB Modular SMU
- BenchVue USB Modular Chassis
- BenchVue USB Modular Source Matrix
7 Select the USB modular application you required and click Install.
Follow the instructions as prompted during the installation.
9 Click Finish when the installation has completed.
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G. Connect the Module to Your PC

Ensure that the Measurement Manager is installed before proceeding. See “E.
Install the Keysight Measurement Manager” on page 25 for more information
on the Measurement Manager installation procedure.

Ensure that the BenchVue USB Modular application is installed before
proceeding. See “F. Install the BenchVue USB Modular Application” on
page 26 for more information on the Measurement Manager installation
procedure.

Do not connect the modular product to any USB port on your PC until all
installations are completed.

After all the software and driver installations have completed, connect the
power cord to the AC/DC power adaptor. The AC/DC power adaptor
requirements are 100 to 240 VAC, 50/60 Hz, with an output voltage of
+12 VDC.

Insert the DC output plug from the AC/DC power adaptor to the power jack on
the rear panel of the modular product.

Connect the modular product to any USB port on your PC with the bundled
USB cable.

Your PC will automatically detect the connected unit.
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H. Verify Your Module Connection on Connection Expert

The Connection Expert is one of the utilities in the Keysight 10 Libraries Suite. The
Connection Expert configures the connected instrument(s) and enables
communication. It is able to automatically detect any modular product plugged
into the PC.

1 Apply power to the PC and to the installed modular product(s).

2 If the Connection Expert is already running, click & to identify any hardware
you have just installed or re-connected.

3 If the Connection Expert is not already running, run it now to verify your 1/0

configuration(s): In the Windows Notification area, click the 10 icon (), and
then click Connection Expert.

4 We will use the Interactive 10 to quickly verify the connectivity to your
instrument. The Interactive 10 is a software utility that allows you to interact
with an instrument by sending commands to the instrument and seeing the
instrument’s responses.

To start the Interactive 10 from within Connection Expert, click on the
£y

=

Interactive 10 icon (mnteretve )

5 The Interactive 10 dialog will appear. Click Send & Read to send the *IDN?
default command. The instrument response should appear in the Instrument
Session History panel.

6 If the Connection Expert can successfully communicate with your modular
product, this indicates that the instrument is installed correctly.
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|. Launch the Keysight Measurement Manager or BenchVue USB
Modular Product Application

To launch the Keysight Measurement Manager

The Measurement Manager will launch the appropriate measurement
application depending on the USB modular product selected. See the Keysight
Measurement Manager Help File for further information pertaining to your
modular product application software.

Double-click the Keysight Measurement Manager software icon to launch the
software.

To launch the Keysight BenchVue USB Modular application

- Ensure that you have installed the BenchVue USB Modular application before
proceed to this step.

- See the Pathwave BenchVue application Help File for further information to
your modular product application software.

1 Double-click the Keysight BenchVue icon(g) to open the BenchVue
software. You can also launch the BenchVue software via Keysight Connection
Expert.

On the main page, click Applications to view the list of application.

Select the BenchVue USB Modular application and click Launch to launch the
application.
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USB Modular Products and Systems Chassis

30

The Keysight U2781A USB modular products chassis is a portable chassis that is
able to house up to six USB modular devices. It is equipped with USB
plug-and-play connectivity and is compliant to the USBTMC-USB488.2

standards !/, allowing it to work seamlessly with the Measurement Manager
software.

Purchasing a U2781A chassis enables you to add synchronization capability
between modules via a star trigger bus. For more details on the U2781A chassis,
refer to the Keysight U2781A USB Modular Products Chassis User's Guide.

Figure 1-3 The U2781A chassis connected to a PC

Chassis installation

The L-Mount kit is to be installed on your module. The following instructions
describe the simple procedure of installing the L-Mount kit and your module into
the U2781A chassis.

1 Unpack the L-Mount kit from the packaging.
2 Remove your module from the bumper casing.

3 Using a Phillips screwdriver, fasten the L-Mount kit to your module.

[1] Compatible with Microsoft Windows operating systems only.
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4 Insert your module into the U278TA chassis with the 55-pin backplane
connector positioned at the bottom of the module. See the 55-pin backplane
connector pin configuration for more information.

5 Once you have slotted in the module, tighten the screws on the L-Mount kit to
secure the connection to the chassis.

55-pin backplane connector pin configuration

The 55-pin backplane connector is used when your module is slotted into the
U2781A chassis. Refer to Table 1-1 for the SSI connector pin descriptions.

GND GND GND GND GND GND GND GND GND GND GND F
NC NC NC NC NC NC NC NC VBUS GND | USB_D- E
GND TRIG3 | GND TRIG2 GND TRIG1 GND TRIGO GND GND |USBD+| D
TRIG4 GND | TRIGS GND TRIG6 GND TRIG7 GND +12V | +12V GND c
nBPUB [ CLK1OM [ GND | STAR_TRIG GA2 GA1 GAO NC +12V | +12V | +12V B
NC NC NC NC NC NC NC NC +12V | #12V | 12V A
11 10 9 8 7 6 5 4 3 2 1
Figure 1-4 55-pin backplane connector pin configuration
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Table 1-1

SSI connector pin description

SS| timing signal Functionality

GND Ground

NC Not connected

VBUS USB bus power sensing input
USB_D+, USB_D- USB differential pair

TRIGO ~ TRIG7 Trigger bus

+12V +12 V power with 4 A current
nBPUB USB backplane input detect
CLK1OM 10 MHz clock source
STAR_TRIG Star trigger

GAQ, GA1, GA2 Geographical address pin
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Additional Information

Windows 7

When installing the Keysight USB Modular Instrument driver on a computer
running Windows 7, you may experience the following issues:

Driver installation failure.

Computer-to-hardware connection failure after a successful driver installation.

If these issues arise, refer to the steps below:

1

Compare the file size of the downloaded setup file with the file size as stated
on the Web. If the size of the downloaded setup file is smaller, this may
indicate that the setup file is corrupted. In this case, download the setup file
again and cross-check the file size before proceeding with installation.

Ensure that you are logged into your computer with Administrator privileges.

Set the User Account Control (UAC) to the lowest security level to prevent the
operating system from interfering with the installation program.

Ensure that your computer is running the latest version of 10 Libraries Suite
(version 16.2 or greater).

Reinstall the latest version of AMM with prerequisites (version 2.2.1.0 or
greater).

If you are still unable to establish a successful connection after following the steps
above, please contact your nearest Keysight Support toll-free number.
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Software drivers
Software component and application for MATHLAB DAQ Adapter is available.

To install the MATLAB DAQ Adaptor

Download and install the MATHLAB DAQ adapter at https://www.keysight.com/
us/en/lib/software-detail/computer-software/
using-keysights-u2500a-series-usb-modular-data-acquisition-with-matlab-2209
240.html.

In order to use these devices with MATLAB, you need to install the MATLAB and
Keysight software components and applications, connect the DAQ modular
product, and install the respective drivers. A MATLAB example is provided at:

- www.keysight.com/find/matlab_u2300a for the U2300A Series DAQ
- www.keysight.com/find/matlab_u2500a for the U2500A Series DAQ
- www.keysight.com/find/matlab_u2600a for the U2600A Series DIO

- For more information on how to install the MATLAB DAQ Adaptor, see the
respective product series’ Using the USB Multifunction Data Acquisition
Devices with MATLAB Software Quick Start Guides.

- You can install the MATLAB software directly from the MathWorks website.

34
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Sample codes

Sample codes for the Keysight VEE, LabVIEW, and Microsoft (C#, C++, VB7, and

VBB6) software platforms are provided to help you get started with your modular
product.

To view the sample codes, go to C://Program Files (x86) > IVI Foundation > IVI >
Drivers > <module model> > Examples.

Command logger and code converter

The Measurement Manager offers you quick and easy configuration and control
without the need for programming work. To further simplify your work, you can
use the provided Command Logger function that logs the configuration
commands and easily convert them to snippets of Keysight VEE, Microsoft Visual
Basic, Microsoft Visual C#, or Microsoft Visual C++ codes.

- To launch the Command Logger function: launch the Measurement Manager,
and go to Tools > Command Logger....

# Agilent Measurement Manager,

File  Edit  View | Tools | Help

Fale=N = APy &) Select Device ..

Command Logger..,

License Panel
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Ei Command Logger EEx

File  Control
P Dstart [ save 3 Clear Display
Fiter Options: | Ng Fiter e
Date Time, Device Type | Command Remarks
Check All Uncheck Al

- To convert the logged commands in to other languages: from the Command
Logger window, click File > Convert Command File.

Convert Command EE]

Select software language:

& agilent VEE 85 and above

() Microsoft Vizual Basic 2005
HMicrosoft Visual CH 2005
Microsoft Visual C++ 2005

oK ] [ Cancel

For more information on how to use the Command Logger application, refer to

NOTE the Keysight Measurement Manager Help File.
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Activate your device license

If you have purchased a with an Option, you are required to activate the device
license before you can use its additional feature(s). You may activate the device
license through the Software Licensing application in the Measurement Manager.

7 Software Licensing

i G Refresh || g Activate License || =] verify License J

Lizense File: Brawse:

Figure 1-5 Software Licensing application

- You do not need to perform this procedure if you have not purchased a
modular product with an Option. Please refer to the respective User's Guide
of your modular product to find out more about the Option(s) available with
your modular product.

- If you do not wish to install the Measurement Manager, you will need to
launch the Software Licensing stand-alone installer. Select Software
Licensing on the Keysight Modular Products Installation Menu, and follow
the instruction on-screen.
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- To activate your device license, launch the Measurement Manager and go to
Tools > License Panel.

# Agilent Measurement Manager

File  Edit  View | Tools | Help

a (== U ‘ ‘i = q Select Device...
=

Command Logger..,

License Panel

NOTE You will require a valid device license key (*.lic). If you do not have a device

license key, you will need to redeem your device license key at
www.keysight.com/find/softwarelicense. Follow the on-screen instructions to
redeem a valid license key for your device.

- To verify your device license(s) from the Software Licensing window, click
Verify License > Update License.

7 Software Licensing

Pt | @ Activate License || =] verify License ]

Device Model | Serial Mumber | Option Number | Remark.

u27614 MY00D000S7 | U2761A-800 2 MHz Arbitrary wawvetorm upgrade
u27e1a MYOO0000Z25 | U27E14A-800 2 MHz Arbitrary wavelorm wparade

NOTE For more information on how to use the Software Licensing application, refer to
the Keysight Measurement Manager Help File.
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l'adresse http://www.keysight.com/go/
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conformité.

Droits du Gouvernement des
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La licence stipulée dans ['EULA représente
le pouvoir exclusif par lequel le
gouvernement des Etats-Unis peut utiliser,
modifier, distribuer ou divulguer le logiciel.
L'EULA et la licence mentionnées dans les
présentes, n'imposent ni n'autorisent, entre
autres, que Keysight : (1) Fournisse des
données techniques relatives aux logiciels
informatiques commerciaux ou a la
documentation afférente qui ne sont pas
mis habituellement a la disposition du
public ; ou (2) Renonce aux ou confére les
droits gouvernementaux en plus des droits
habituellement mis a la disposition du
public pour utiliser, modifier, reproduire,
publier, exécuter, afficher ou divulguer des
logiciels informatiques commerciaux ou la
documentation afférente. Aucune exigence
gouvernementale autre que celle établie
dans l'EULA ne s'applique, sauf dans la
mesure oU ces conditions, droits ou
licences sont explicitement requis de la
part de tous les prestataires de logiciels
commerciaux conformément

ala FAR et au DFARS et sont
spécifiquement établis par écrit ailleurs
dans 'EULA. Keysight n'est tenu par
aucune obligation de mettre a jour, réviser
ou modifier de quelque maniere que ce soit
le Logiciel. En ce qui concerne toutes les
données techniques telles que définies par
la FAR 2.101, conformément aux FAR
12.211 et 27.404.2 et au DFARS 227.7102,
le gouvernement des Etats-Unis acquiert
des droits n’excédant pas les Droits limités
tels que définis dans la FAR 27.401 ou le
DFAR 227.7103-5 (c), applicables dans
toutes les données techniques.

Garantie

LES INFORMATIONS CONTENUES DANS
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SI KEYSIGHT A PASSE UN AUTRE
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CONDITIONS GENERALES D’'UTILISATION
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Informations relatives a la
sécurité

La mention ATTENTION signale un
danger pour le matériel. Si la manceuvre
ou la procédure correspondante n’est
pas exécutée correctement, il peut y
avoir un risque d’'endommagement de
'appareil ou de perte de données
importantes. En présence de la mention
ATTENTION, il convient de ne pas
poursuivre tant que les conditions
indiquées n'ont pas été parfaitement
comprises et remplies.

AVERTISSEMENT

La mention AVERTISSEMENT signale
un danger pour la sécurité de
Uopérateur. Si la manceuvre ou la
procédure correspondante n’est pas
exécutée correctement, il peut y avoir
un risque grave, voire mortel pour les
personnes. En présence de la mention
AVERTISSEMENT, il convient de ne pas
poursuivre tant que les conditions
indiquées n'ont pas été parfaitement
comprises et respectées.
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Symboles de sécurité

Les symboles suivants portés sur l'instrument et contenus dans sa documentation
indiquent les précautions a prendre afin de garantir son utilisation en toute
Sécurité.

— Courant continu (CC) Courant alternatif (CA)

Attention, risque de danger

’\/
—_— . . (reportez-vous a ce manuel pour des
~_ Courant alternatif et continu A

informations détaillées sur les
avertissements et les mises en garde)
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Consignes de sécurité

AVERTISSEMENT

Lisez les informations ci-dessous avant d’utiliser cet instrument. Les descriptions et
instructions de ce manuel s'appliquent a tous les instruments de la famille de produits
modulaires Keysight. Pour obtenir des consignes de sécurité plus pertinentes,
reportez-vous au Guide de ['utilisateur correspondant de votre produit modulaire.

- Nutilisez pas 'appareil s'il parait endommagé. Vérifiez 'état du boitier
avant d’utiliser 'appareil. Recherchez des fissures ou des trous.

- Nutilisez pas l'appareil a proximité de vapeurs, de gaz explosifs ou dans
des environnements humides.

- Respectez tous les repéres figurant sur l'appareil avant d’établir un
branchement.

- Eteignez 'appareil et l'alimentation du systéme d’application avant de
brancher les bornes d’E-S.

- Lors de l'entretien de l'appareil, utilisez exclusivement les piéces de
rechange indiquées.

- Ne faites pas fonctionner U'appareil avec son capot démonté ou détaché.

- Ne connectez aucun céble ou bornier avant d’avoir effectué la procédure
d’autotest.

- Afin d’éviter tout danger, utilisez uniguement 'adaptateur de puissance
fourni par le fabricant.

- Toute décharge électrostatique (ESD) peut détériorer les composants de
l'appareil et des accessoires. Les cables et cordons doivent d’abord étre
branchés au connecteur d’entrée, puis recouverts par le
protege-connexions avant d’étre raccordés au connecteur de sortie pour
éviter toute décharge électrostatique.

- Silappareil est utilisé d’'une maniére non recommandée par le fabricant,
il se peut que la protection de l'appareil ne soit plus efficace.

- Nettoyez le boitier a l'aide d'un chiffon doux non pelucheux légerement
humidifié. N'utilisez pas de détergent, de liquides volatiles ou de solvants
chimiques.

- Ne bloquez aucun des orifices d’aération de 'appareil.
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Marguages réglementaires

Le marquage CE est une marque

déposée de la Communauté
. La marque RCM est une marque
européenne. Cette marque CE montre N , ;
ue le produit est conforme a toutes déposée de lAustralian
A gue € produtt est ¢ , Communications and Media Authority.
les Directives juridiques européennes

pertinentes.

=

S

Cet équipement est conforme aux
ICES/NMB-001 indique que cet exigences de marquage de la directive
appareil ISM est conforme a la relative aux DEEE (2002/96/CE).

ICES/NMB-001 norme canadienne ICES-001. L'étiquette apposée sur le produit
Cet appareil ISM est conforme a la indique que vous ne devez pas jeter ce
norme NMB-001 du Canada. produit électrique ou électronique

avec les ordures ménageres.

134

Ce symbole indique a période

pendant laquelle aucune détérioration
Le marquage CSA est une marque . :
ou fuite de substances toxiques ou

‘SD ® déposee d.e lAssocwaﬂoq canadienne 40 dangereuses n'est & attendre dans

c us de nor_m_ahsatmn (Canadian Standards le cadre d’une utilisation normale.
Association). La durée de vie prévue du produit est

de quarante ans.

6
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Directive européenne 2002/96/CE relative aux déchets
d'équipements électrigues et électroniques (DEEE)

Cet équipement est conforme aux exigences de marquage de la directive relative
aux DEEE (2002/96/CE). L'étiquette apposée sur le produit indique que vous ne
devez pas jeter ce produit électrique ou électronique avec les ordures ménageres.

Catégorie du produit :
en référence aux types d’équipement définis a 'Annexe 1 de la directive DEEE, cet
instrument est classé comme « instrument de surveillance et de controle ».

L’étiquette apposeée sur 'appareil est celle représentée ci-dessous.

Ne le jetez pas avec les ordures ménageres.

Pour renvoyer cet instrument indésirable, contactez le centre de service le plus
proche Keysight ou visitez le site http://about.keysight.com/en/companyinfo/
environment/takeback.shtml pour plus d'informations.

Support technigue et commercial

Pour contacter Keysight afin d'obtenir un support technique et commercial,
consultez les liens d'assistance des sites Web Keysight suivants :

- www.keysight.com/find/usbmodular
(assistance et informations spécifiques au produit, mises a jour du logiciel et
de la documentation)

- www.keysight.com/find/assist
(informations de contact dans le monde entier pour les réparations et le support)
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1 Produits et systemes modulaires USB Keysight

Présentation de Produits et systemes modulaires USB

Les Produits et systemes modulaires USB sont constitués d'une gamme
d'instruments de test et de mesure vous offrant le choix et la souplesse
nécessaires a la création de solutions capables d'évoluer en fonction des
modifications de vos criteres de test.

Figure 1-1 La gamme Produits et systemes modulaires USB

Résumé des caractéristiques standard d'un produit modulaire

- Equipé d'une connectivité USB 2.0 haute vitesse, capable de gérer des vitesses
atteignant 480 Mo/s.

- Nécessite un ordinateur pour fonctionner.

- Accompagné du logiciel Keysight Measurement Manager pour pouvoir
commencer immédiatement les mesures.

- Prend en charge le programme Keysight Open et est compatible avec une
large gamme d'environnements de développement d'applications (ADE).

- Fonctionne comme un instrument autonome ou comme un module combiné
lorsqu'il est utilisé avec le chassis produit modulaire U2781A USB Keysight
(capable d'accueillir jusqu'a six modules individuels)
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7

Eléments de la version standard

Pour obtenir la liste des articles standard achetés pour chague produit modulaire,
reportez-vous aux guides d'utilisation respectifs de votre produit modulaire.
Vérifiez les éléments de la version standard. Si un composant est absent ou
endommagé, contactez votre distributeur Keysight le plus proche.

Inspection et maintenance

Inspection initiale

Des la réception de votre produit modulaire, inspectez 'appareil a la recherche
d’éventuels détériorations évidentes susceptibles de se produire pendant le
transport. En cas de détérioration, contactez immédiatement votre distributeur
Keysight le plus proche. Conservez 'emballage d’origine au cas ou le produit
modulaire doit étre renvoyé ultérieurement a Keysight.

Maintenance générale

Les réparations non décrites dans le manuel de votre produit modulaire ne
doivent étre effectuées que par un personnel qualifié.

1 Mettez l'appareil hors tension, puis débranchez le cordon d'alimentation et le
cable d'E/S de l'appareil.

Sortez l'appareil de son boftier caoutchouc.
Retirez la poussiere qui s'est accumulée sur l'appareil.

Essuyez l'appareil avec un chiffon sec et remettez le pare-choc en place.
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Installation et configuration

Suivez les instructions étape par étape indiquées dans le diagramme de taches
suivant pour commencer la préparation et linstallation de votre produit modulaire.

C A. Vérifiez votre systeme )
Y

( B. Installer Keysight 10 Libraries Suite >
Y

C C. Installez le pilote matériel du module )
Y

( D. installez le pilote du module IVI-COM >

Y

( E. Installez le programme Keysight Measurement Manager >

Y

C F. Installez l'application modulaire USB BenchVue )

Y

( G. Connectez le module a votre ordinateur )

Y

( H. Vérifiez la connexion du module sur Connection Expert >

Y

<I. Lancez Keysight Measurement Manager ou l'application>

du produit modulaire USB BenchVue

Figure 1-2 Diagramme d'installation et de configuration

16 Keysight Produits et systemes modulaires USB Guide de mise en route



Produits et systemes modulaires USB Keysight 1

A. Vérifiez votre systeme

Avant de commencer linstallation et la configuration, vérifiez que votre ordinateur
satisfait la configuration systeme minimale.

Exigences Systeme d'exploitation Systeme d'exploitation Systeme d'exploitation
Windows® XP Windows Vista® Windows 7
Systeme d’exploitation Service Pack 3 (ou version Service Pack 1 et 2 pour Windows 7 (32 bits et 64
ultérieure) pour Windows XP Windows Vista (32 bits)™! bits)lcld]
Vitesse du processeur 600 MHz ou plus 1 GHz 32 bits (x86) 3 GHz 32 bits (x86)
800 MHz recommandés
Mémoire 256 Mo au minimum (1 Goou 1 Go au minimum 2 Go au minimum
plus recommandé)
Espace disque 1,5 Go au minimum 1,5 Go au minimum 1,5 Go au minimum
Vidéo Super VGA (800 x 600) Prise en charge de la carte Prise en charge de la carte
256 couleurs ou plus graphique Directx® 9 avec graphique DirectX 9 avec 128
128 Mo de mémoire Mo de mémoire graphique
graphique recommandgéel®! recommandgel®
Lecteur de CD-ROM ou de Nécessaire Nécessaire Nécessaire
pvD-Rom [f]
Navigateur Microsoft Internet Explorer®  Microsoft Internet Explorer 7 Microsoft Internet Explorer 7
5.01 ou version ultérieure ou version ultérieure ou version ultérieure
al Editions de Windows XP prises en charge — Familiale ou Professionnelle

T 5 T =

(Windows-on-Windows 64-bit).

=

La carte graphique Super VGA est prise en charge pour Windows Vista et Windows 7.

=

Keysight Produits et systémes modulaires USB Guide de mise en route

Editions de Windows Vista (32 bits) prises en charge — Familiale Basique, Familiale Premium, Professionnel ou Intégrale
c] Editions de Windows 7 (32 bits et 64 bits) prises en charge — Familiale Basique, Familiale Premium, Professionnel, Entreprise ou Intégrale
]

Keysight Measurement Manager for Windows 7 64-bit support est une application 32-bit exécutée sur un émulateur WOW64

Le type de support fourni avec le produit détermine si un lecteur de CD-ROM ou bien de DVD-ROM est nécessaire.
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Configuration logicielle requise Disponibilité

Keysight 10 Libraries Suite 15.5 Disponible sur www.keysight.com/find/iosuite

Keysight T&M Toolkit Runtime
version 2.1

Correctif Keysight T&M Toolkit
Redistributable Package 2.1

Associé au programme d'installation de l'application Keysight Measurement Manager

Associé au programme d'installation de l'application Keysight Measurement Manager

Microsoft .NET Framework

version 2.0 Associé au programme d'installation de ['application Keysight Measurement Manager
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B. Installer Keysight 10 Libraries Suite

Sila version 15.5 ou ultérieure de Keysight 10 Libraries Suite est installée sur votre
ordinateur, vous pouvez passer a « C. Installez le pilote matériel du module »,
page 21. Si ce n'est pas le cas, veuillez effectuer cette procédure pour installer
Keysight 10 Libraries Suite.

Vous devez disposer des privileges d'administrateur pour installer Keysight 10
Libraries Suite Connection Expert.

1 \Vérifiez que l'ordinateur respecte la configuration systeme requise (Voir
« A. \érifiez votre systeme », page 17.)

2 Débranchez tout appareil connecté a votre ordinateur et fermez toutes les
autres applications ouvertes sur cet ordinateur.

3 Téléchargez et installez la suite Keysight 10 Libraries a partir de
www.keysight.com/find/iosuite.

Suivez les instructions a l'invite pendant l'installation

Cliguez sur Terminer (Finish) lorsque linstallation est terminée.

- Sivous installez une carte PCI dans votre ordinateur en méme temps que
Keysight IO Libraries Suite, un conflit peut se produire. La boite de dialogue
« Nouveau matériel détecté » pour la carte PCI doit étre fermée avant de
poursuivre l'installation. Dans le cas contraire, l'installation de Keysight |10
Libraries Suite s'arréte jusqu'a ce que l'installation de la carte PCI soit
terminée.

- Siun logiciel NI est installé (tel que NI MAX, etc.), tous les services NI doivent
étre arrétés avant l'installation de Keysight 10 Libraries Suite.

- Ces deux modules sont installés dans les dossiers par défaut. Toutefois si
vous devez installer VI Components dans un autre emplacement,
reportez-vous a la section Custom Installation of IVI Shared Components du
manuel Keysight |0 Libraries Suite Connectivity Guide.

- Si Connection Expert est déja en cours d'exécution, cliquez sur Tout
actualiser Refresh All pour identifier tout matériel que vous venez d'installer
ou de reconnecter.
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- Chaque installation de Keysight 10 Libraries Suite est une « installation
compléte »
Dans les versions antérieures de Keysight 10 Libraries Suite, une option
permettant d'installer Keysight 10 Libraries Suite en tant que version
compléte ou version d'exécution était fournie. A partir de la version 14.0 de
Keysight IO Libraries Suite, le processus d'installation fournit une installation
compléte pour tous les utilisateurs (c'est-a-dire qu'il n'existe plus d'option de
version d'exécution). Cela signifie que chaque installation inclut désormais
les composants de développement du logiciel Keysight IO Libraries Suite,
qui vous permettent de développer vos propres programmes d'E/S. Si vous
souhaitez réduire au minimum l'espace occupé par le logiciel installé :
dans la boite de dialogue Select Features (Sélectionner les fonctionnalités),
sélectionnez Custom Installation (Installation personnalisée), puis assurez-vous
que les manuels et les exemples de programme sont désélectionnés.

- L'option Typical installe toutes les fonctionnalités appropriées a votre
configuration dans des emplacements prédéfinis de l'ordinateur. Avec
une installation standard, si le logiciel VISA d'un autre fournisseur est déja
installé sur l'ordinateur, Keysight VISA est installé comme application VISA
secondaire. Si aucun autre logiciel VISA n'est détecté sur cet ordinateur,
Keysight VISA est installé comme application principale. (Voir aussi
« Utilisation de Keysight VISA en mode cbte a cote » dans le Keysight 10
Libraries Suite Connectivity Guide

- Si Microsoft .NET Framework version 2.0 n'a pas été installé précédemment
sur votre PC, Keysight 10 Libraries Suite linstallera ; cela peut prendre
jusqu'a dix minutes. Microsoft .NET Framework fournit l'infrastructure
nécessaire pour les utilitaires Keysight 10 Libraries Suite, ainsi que pour les
outils de programmation .NET et de nombreuses autres applications. Vous
n'aurez besoin d'installer .NET Framework qu'une seule fois, méme si vous
supprimez et réinstallez ou mettez a niveau votre Keysight IO Libraries Suite.
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C. Installez le pilote matériel du module
- Vérifiez que le produit modulaire est déconnecté de votre ordinateur avant
d’installer le pilote.

- Vérifiez que la version 15.5 ou supérieure de Keysight IO Libraries Suite
est installée avant de continuer. Pour plus d'informations sur la procédure
d'installation de Keysight 10 Libraries Suite, reportez-vous a la section
« B. Installer Keysight |0 Libraries Suite », page 19.

1 Veérifiez que U'ordinateur respecte la configuration systeme requise (Voir
« A. Vérifiez votre systéme », page 17.)

2 Deébranchez tout appareil connecté a votre ordinateur et fermez toutes les
autres applications ouvertes sur cet ordinateur.

3 Téléchargez et installez le pilote matériel du module a partir du site
www.keysight.com/find/usbmodular.

Suivez les instructions a l'invite pendant l'installation

5 Cliquez sur Terminer (Finish) lorsque U'installation est terminée.
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D. installez le pilote du module IVI-COM

Les pilotes IVI-COM sont utilisés pour programmer les instruments de test dans
un environnement [VI-COM, tandis que 'adaptateur DAQ MATLAB permet de
controler les acquisitions de données produit modulaire (séries U2300A, U2500A
et U2600A) dans un environnement MathWorks.

- Vérifiez que le produit modulaire est déconnecté de votre ordinateur avant
d’installer le pilote.

- Veérifiez que la version 15.5 ou supérieure de Keysight IO Libraries Suite
est installée avant de continuer. Pour plus d'informations sur la procédure
d'installation de Keysight 10 Libraries Suite, reportez-vous a la section
« B. Installer Keysight 10 Libraries Suite », page 19.

1 Veérifiez que l'ordinateur respecte la configuration systéme requise (Voir
« A. Vérifiez votre systeme », page 17.)

2 Débranchez tout appareil connecté a votre ordinateur et fermez toutes les
autres applications ouvertes sur cet ordinateur.

3 Téléchargez et installez le pilote du module IVI-COM a partir du site
www.keysight.com/find/usbmodular.

Suivez les instructions a l'invite pendant l'installation.

Cliquez sur Terminer (Finish) lorsque linstallation est terminée.

- Le module IVI Shared Components doit également étre installé avant
d'installer le pilote IVI-COM. Trouvez les composants partagés IVI sur le site
Web IVl ici : www.ivifoundation.org.

- Sinécessaire, le pilote IVI-COM peut également étre téléchargé a partir de ce
site : www.keysight.com/find/ivi-com.
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E. Installez le programme Keysight Measurement Manager

Vérifiez que la version 15.5 ou supérieure de Keysight 10 Libraries Suite
est installée avant de continuer. Pour plus d'informations sur la procédure
d'installation de Keysight 10 Libraries Suite, reportez-vous a la section

« B. Installer Keysight |0 Libraries Suite », page 19.

1 Débranchez tout appareil connecté a votre ordinateur et fermez toutes les
autres applications ouvertes sur cet ordinateur.

2 Téléchargez et installez le logiciel Keysight Measurement Manager & partir du

site www.keysight.com/find/amm.
Suivez les instructions a l'invite pendant l'installation.

Cliguez sur Terminer (Finish) lorsque linstallation est terminée.

Keysight Produits et systémes modulaires USB Guide de mise en route
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F. Installez l'application modulaire USB BenchVue

24

Vérifiez que la version 15.5 ou supérieure de Keysight 10 Libraries Suite
est installée avant de continuer. Pour plus d'informations sur la procédure
d'installation de Keysight |0 Libraries Suite, reportez-vous a la section

« B. Installer Keysight 10 Libraries Suite », page 19.

1 Débranchez tout appareil connecté a votre ordinateur et fermez toutes les
autres applications ouvertes sur cet ordinateur.

2 Téléchargez et installez le logiciel Keysight BenchVue Complete Collection a
l'adresse www.keysight.com/find/benchvue.

Suivez les instructions a l'invite pendant l'installation.

Cliquez sur Terminer (Finish) lorsque linstallation est terminée.

5 Double-cliquez sur l'icone Keysight BenchVue (Q) pour ouvrir le logiciel
BenchVue.

6 Sur la page principale, cliquez sur Applications pour afficher la liste des
applications. Vous trouverez ci-dessous la liste des applications modulaires
USB que vous devrez peut-étre installer en fonction du produit :

- Baie modulaire USB BenchVue

- Multimétre numérique modulaire USB BenchVue

- Oscilloscope modulaire USB BenchVue

- Générateur de fonctions modulaires USB BenchVue
- Appareil modulaire de mesure-source USB BenchVue
- Chaéssis modulaire USB BenchVue

- Matrice de source modulaire USB BenchVue

7 Sélectionnez l'application modulaire USB requise et cliquez sur Install
(Installer).

Suivez les instructions a l'invite pendant l'installation.

9 Cliquez sur Terminer (Finish) lorsque linstallation est terminée.
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G. Connectez le module a votre ordinateur

- Vérifiez que le logiciel Measurement Manager est installé avant de
poursuivre. Reportez-vous a l'étape « E. Installez le programme Keysight
Measurement Manager », page 23 pour savoir comment installer Agilent
Measurement Manager.

- Assurez-vous que l'application modulaire USB BenchVue est installée avant
de continuer. Reportez-vous a l'étape « F. Installez 'application modulaire
USB BenchVue », page 24 pour savoir comment installer Agilent
Measurement Manager.

- Ne connectez pas le produit modulaire a un port USB de votre PC tant que
toutes les installations ne sont pas terminées.

1 Une fois toutes les installations de logiciel et de pilote terminées, branchez le
cordon d'alimentation a l'adaptateur secteur. Les exigences de l'adaptateur
secteur AC/DC sont de 100 a 240 VAC, 50/60 Hz, avec une tension de sortie
de +12 VDC.

2 Branchez la fiche de sortie CC de |’ 'adaptateur au connecteur d’alimentation
situé sur le panneau arriere du produit modulaire.

3 Connectez le produit modulaire a un port USB de l'ordinateur a l'aide du céble
USB inclus.

4 Votre PC détecte automatiquement ['unité connectée.
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H. Vérifiez la connexion du module sur Connection Expert

26

Connection Expert est ['un des utilitaires de Keysight 10 Libraries Suite. Il
configure les instruments connectés et établit la communication. Il peut détecter
automatiguement tout produit modulaire branché sur Uordinateur.

1

2

Mettez Uordinateur et les produits produit modulaire installés sous tension.

Si Connection Expert est déja en cours d'exécution, cliquez sur =& pour
identifier tout matériel que vous venez d'installer ou de reconnecter.

Si Connection Expert n'est pas déja en cours d'exécution lancez-le maintenant
et vérifiez la ou les configurations des E/S : Dans la zone de notification

Windows, cliquez sur l'icone E/S ([&), puis sur Connection Expert.

Nous utiliserons l'E/S interactive pour vérifier rapidement la connectivité a
votre instrument. L'E/S interactive est un utilitaire logiciel qui vous permet
d’interagir avec un instrument en envoyant des commandes a l'instrument et
en affichant les réponses de linstrument.

Pour démarrer I'E/S interactive a partir de Connection Expert, cliquez sur
i)

—

l'icone E/S interactive (memeive ),

La boflte de dialogue E/S interactive s'affiche. Cliquez sur Send & Read
(Envoyer et lire) pour envoyer la commande *IDN? par défaut. La réponse de
linstrument doit apparaitre dans la section Instrument Session History
(Historique des sessions d’instrument).

Si Connection Expert peut communiquer correctement avec le produit
modulaire, alors Uinstrument est installé correctement.
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|. Lancez Keysight Measurement Manager ou l'application du
produit modulaire USB BenchVue

Pour lancer le gestionnaire de mesures Keysight

Measurement Manager lance l'application de mesure correspondant au produit
modulaire USB sélectionné. Reportez-vous au fichier d'aide Keysight
Measurement Manager Help File pour obtenir des informations sur le logiciel
applicatif de votre produit modulaire

Double-cliquez sur l'icdne du logiciel Keysight Measurement Manager pour lancer
le logiciel.

Pour lancer l'application modulaire USB Keysight BenchVue

- Assurez-vous d'avoir installé l'application modulaire USB BenchVue avant de
passer a cette étape.

- Consultez le fichier d'aide de l'application Pathwave BenchVue pour plus
d'informations sur votre logiciel d'application modulaire.

1 Double-cliquez sur l'icone Keysight BenchVue (@) pour ouvrir le logiciel
BenchVue. Vous pouvez également lancer le logiciel BenchVue via Keysight
Connection Expert.

2 Sur la page principale, cliquez sur Applications pour afficher la liste des
applications.

3 Sélectionnez l'application modulaire USB BenchVue et cliquez sur Launch
pour lancer l'application.
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Produits et systemes modulaires USB Chéssis

28

Le chassis U2781A USB produit modulaire Keysight est un chassis portable
capable d'héberger jusqu'a six périphériques modulaires USB. Equipé d'une
connectivité USB plug-and-play et conforme aux normes USBTMC-USB488.211]
il peut fonctionner en toute transparence avec le logiciel Measurement Manager.

L'achat d'un chassis U2781A vous permet d'ajouter une fonction de
synchronisation entre les modules via un bus de déclenchement en étoile. Pour
plus de détails sur le chassis U2781A, reportez-vous au Guide d'utilisation du
chéssis de produits modulaires USB Keysight.

Figure 1-3 Le chassis U2781A connecté a un ordinateur.

Installation en chassis

Le kit de montage en L doit &tre monté sur le module. Les instructions suivantes
décrivent la procédure d'installation du kit de montage en L et du module dans le
chassis U2781A.

1 Retirez le kit de montage en L de son emballage.
2 Sortez le module de son boftier caoutchouc.
3 Alaide d’un tournevis Phillips, fixez le kit de montage en L sur le module .

[1]1 Compatible uniguement avec des systémes d'exploitation Microsoft Windows.
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4 Insérez le module dans le chassis U2781A, connecteur de fond de panier a
55 broches vers le bas du module. Pour plus d'informations, reportez-vous
a la section Configuration des broches du connecteur de fond de panier
55 broches.

5 Une fois le module inséré dans le chassis, serrez les vis du kit de montage en L
pour maintenir la fixation sur le chassis.

Configuration des broches du connecteur de fond de panier
55 broches

Le connecteur de fond de panier a b5 broches est utilisé lorsque le module est
inséré dans le chassis USB U2781A. Reportez-vous au Tableau 1-1 pour obtenir la
description des broches du connecteur SSI.

TERRE | TERRE | TERRE TERRE TERRE [ TERRE | TERRE | TERRE | TERRE | TERRE [ TERRE F
NC NC NC NC NC NC NC NC VBUS | TERRE |USB.D-| E
TERRE | TRIG3 | TERRE TRIG2 TERRE | TRIGT | TERRE [ TRIGO | TERRE | TERRE |USBD+| D
TRIG4 | TERRE [ TRIGS TERRE TRIG6 | TERRE | TRIG7 | TERRE | +12V [ +12V | TERRE c
nBPUB | CLK10OM [ TERRE | STAR_TRIG GA2 GA1 GAO NC +12V [ #12V | +12V B
NC NC NC NC NC NC NC NC +12V | #12V | 12V A
11 10 9 8 7 6 5 4 3 2 1
Figure 1-4 Configuration des broches du connecteur de fond de panier
55 broches
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Tableau 1-1 Description des broches du connecteur SSI

Signal de synchronisation SSI Fonctionnalité

TERRE Masse

NC Non connecté

VBUS Entrée de détection d’alimentation du bus USB
USB_D+, USB_D- Paire différentielle USB

TRIGO~TRIG7 Bus de déclenchement

+12V Tension +12 V avec courant de 4 A

nBPUB Détection d’entrée de fond de panier USB
CLK10M Source d’horloge 10 MHz

STAR_TRIG Déclenchement en étoile

GAQ, GA1, GA2 Broches d’adressage géographique
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Informations supplémentaires

Windows 7

Lors de l'installation du pilote d'instrument modulaire USB Keysight sur un
ordinateur fonctionnant sous Windows 7, vous pouvez rencontrer les problemes
suivants :

- Echec d'installation du pilote.

~ Echec de connexion entre l'ordinateur et le matériau aprés réussite de

l'installation du pilote.

Si ces problemes surviennent, reportez-vous aux étapes ci-dessous :

1

Comparez la taille du fichier d'installation téléchargé et la taille du fichier
mentionnée sur Internet. Si la taille du fichier d'installation téléchargée est
inférieure, cela peut indiquer que le fichier d'installation est corrompu. Dans ce
cas, téléchargez de nouveau le fichier d'installation et vérifiez la taille avant de
procéder a l'installation.

Assurez-vous que vous avez ouvert une session sur votre ordinateur avec les
privileges d'administrateur.

Réglez le controle de compte d'utilisateur (UAC) sur le niveau de sécurité le plus
faible afin d'empécher que le systeme d'exploitation ne perturbe le programme
d'installation.

Assurez-vous que votre ordinateur dispose de la derniere version de la suite 10
Libraries (version 16.2 ou supérieure).

Réinstallez la derniére version de AMM avec les conditions préalables (version
2.2.1.0 ou supérieure).

Si vous ne parvenez toujours pas a établir une connexion apres avoir effectué ces
étapes, veuillez contacter le numéro gratuit du support Keysight le plus proche.
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Pilotes de logiciel

Un composant logiciel et une application pour 'adaptateur DAQ MATHLAB sont
disponibles.

Pour installer l'adaptateur MATLAB DAQ

Téléchargez et installez l'adaptateur MATHLAB DAQ a l'adresse
https://www.keysight.com/us/en/lib/software-detail/computer-software/
using-keysights-u2500a-series-usb-modular-data-acquisition-with-matlab-2209
240.html.

Pour utiliser ces périphériques avec MATLAB, vous devez installer les

composants logiciels et les applications MATLAB et Keysight, connecter le DAQ
produit modulaireet installer les pilotes correspondants. Un exemple MATLAB
est fourni a :

- www.keysight.com/find/matlab_u2300a pour le DAQ série U2300A
- www.keysight.com/find/matlab_u2500a pour le DAQ série U2500A
- www.keysight.com/find/matlab_u2600a pour la série U2600A DIO

- Pour plus d'informations sur l'installation de 'adaptateur MATLAB DAQ,
reportez-vous aux guides de démarrage rapide de la série de produits
correspondante Utilisation des périphériques d'acquisition de données
multifonction USB avec le logiciel MATLAB.

- Vous pouvez installer le logiciel MATLAB directement a partir du site Web de
MathWorks.
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Exemples de code

Exemples de codes pour Keysight VEE, LabVIEW et Microsoft (C#, C++, VB7,
Et VB6) des plates-formes logicielles sont fournies pour vous aider & démarrer
avec votre produit modulaire.

Pour afficher les exemples de codes, accédez a C://Program Files (x86) >
IVI Foundation > IVI > Drivers > <module model> > Examples.

Enregistreur de commandes et convertisseur de code

Measurement Manager permet une configuration et une gestion rapides et
simples sans recours a la programmation. Pour faciliter encore votre travail,

vous pouvez utiliser la fonction Command Logger fournie, qui enregistre les
commandes de configuration et les convertit simplement en snippets de code
Keysight VEE, Microsoft Visual Basic, Microsoft Visual C# ou Microsoft Visual C++.

- Pour lancer la fonction Command Logger : lancez le gestionnaire de mesures
et accédez a Tools > Command Logger...

# Agilent Measurement Manager

File Edit Wiew | Tools | Help

He =N = A B Select Device...

Cammand Lagger...

License Panel
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B Command Logger EEx

Ele  Control
: Dstart [ save ) Clear Display
Fiter Dptions: [N Filier 3
Date Time Device Ty | Cormmand Remarks
Check &1 LUncheck Al

Pour convertir les commandes consignées dans dans d'autres langues : dans
la fenétre de l'enregistreur de commandes, cliquez sur File > Convert

Command File

Convert Command [:]@

Select software language:;

®  Agient VEE 85 and above

(O Microsoft Visual Basic 2005
Microsoft Visual C# 2005
Microsoft Visual C++ 2005

oK Cancel
]

Pour de plus amples informations sur l'utilisation de l'application Command

REMARQUE Logger, reportez-vous au fichier d'aide Keysight Measurement Manager Help
File.
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Activation de la licence de l'appareil

Sivous avez acheté une licence avec option, vous devez activer la licence du
terminal avant de pouvoair utiliser ses fonctions supplémentaires. Vous pouvez
activer la licence de l'appareil via l'application Software Licensing du gestionnaire
de mesures.

7 Software Licensing

i f¥pefrech ||of Activate License || =] Verify License |

License File: Browse...

Figure 1-5 Application de licence du logiciel

- Vous n'avez pas besoin d'effectuer cette procédure si vous n'avez pas
acheté un produit modulaire avec une option. Reportez-vous au Guide de
l'utilisateur de votre produit modulaire pour en savoir plus sur les options
disponibles avec votre produit modulaire.

- Sivous ne souhaitez pas installer Measurement Manager, vous devez lancer
le programme d'installation autonome Software Licensing. Sélectionnez
Software Licensing dans le menu d'installation des produits modulaires
Keysight et suivez les instructions a l'écran.
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- Pour activer la licence de votre appareil, lancez Measurement Manager et
accédez a Tools > License Panel.

# Agilent Measurement Manager

File Edit Yiew | Tools | Help

ib (= u | =l = @ Select Device...
-

Command Logger...

License Panel

REMARQUE Vous aurez besoin d'une clé de licence valide (fichier *.lic). Si vous n'avez pas de

clé de licence de terminal, vous devez utiliser votre clé de licence de terminal a
l'adresse www.keysight.com/find/softwarelicense. Suivez les instructions
affichées pour récupérer une clé de licence valide pour votre appareil.

- Pour vérifier la ou les licences de votre terminal a partir de la fenétre licences
logicielles, cliquez sur Verify License > Update License.

Software Licensing

Device Model  Serial Mumber | Option Number | Remark.

u27e1a MY00D000S7 | U2761A-800 2 MHz Arbitrary waveform upgrade
U27E14 MYOO0000Z25 | U27E14A-800 2 MHz Arbitrary waveform upgrade

REMAROUE Pour plus d'informations sur l'utilisation de l'application de gestion des licences
Q logicielles, reportez-vous au fichier d'aide Keysight Measurement Manager Help

File.
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